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Getting Started

Hardware Required
To operate the robot, you’ll need:
e MG400 prot .

e Ethernet cable (included cable
preferred)

e MG400 E-Stop

e If your PC doesn’t have an Ethernet
port, you'll need a USB to Ethernet
adapter

See Connecting to the MG400 for details on cable connections.
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Downloading the Software

You’ll need the MG400 software before getting connected. Download it off the Dobot official
manufacturer’s site or contact your distributor for the most recent version.

The software you need is called “DobotStudio2020”

Home/ Support

MG400 Download Centers

Software User manual SDK 3D Model

DobotSCStudio v2.1.8 228 MB

DobotSCStudio-windows-offline-installer-2.1.8....exe 2021.09. 10

DoboiSCStudio is an industrial robat programming platform launched by Yuejiang, which is suitable for the whole series of industrial robots (SA / SR/ CR / MG400 /
M1Pro). Friendly interface, innovative interactive programming, supporting user secondary development. It also provides kinematics algerithm of various mechanical
structures and integrated virtual simulation environment to realize rapid deployment of various process applications on site

View historical versions ~

DobotStudio2020 v1.3.0 101 MB

DobotStudio20205etup-1.3.0-stable. 202 106.._exe 2021.06. 23

VeVersion Description

DobotStudio New upgrade, better experience

- New features: Points list, /O alias, User coordinate system & Tool coordinate system, and Pallet

- Various programming methods to choose: Teach&Playback, Graphical programming, and Script programming

- New Ul and interaction provide a pleasure user experience.

- design: devices, applications and plug-ins can be extended. More devices and functions will be supported in the future
- Automatic updates keep your software up to date.

More features to be explored!

* The DobotStudio2020 of V1.1.0 version supports MG400 and M1, please try it with the right device.

* Thank you for trying out this stable version. If you find any bugs or have any suggestions, please submit them on the Menu > Help > Feedback page or email to
pm@daobot.cc . We will continue to improve the user experience of the software

If you have trouble downloading directly, click here to download on Google Drive

View historical versions ~

While DobotSCStudio functions with the MG400, we recommend using Dobotstudio2020.
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Connecting to the MG400

Configuring Your Hardware
Before making any connections, be sure your MG400 power switch is set to “off” (O), like shown here:

Make the following connections to the MG400:
e Plug the power connector into a standard US wall outlet
e Plug the DC output of the power connector into the robot port labeled “POWER”
e Plug the E-Stop connector into the port labeled “E-STOP”
e Plug your Ethernet cable into the port labeled “LAN 1” and plug the other end into your PC

The result should look like this:
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Next, flip the ON/OFF switch to the ON position. The switch LED should turn on, as shown here:

LAN 2 USB1 USB2

The LED on the front side of the robot base will now be blinking white to signify that the robot is booting
up. Once the robot is ready for a connection, the LED will be a solid blue:

Robot Booting Robot Ready
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Configuring Your IP-Address
You'll need to configure the IP-Address of the MG400 to be able to connect to it with your computer.?!

Go to the control panel:

Apps Documents web More = _7

Control Panel

Control Panel
[¥ Settings > App
LCC Control Center >
E Intel® Graphics Control Panel > 7 Open
B4 UltraVNC Server Settings > v
Run > Recent
= .
Windows Administrative Tools > Network and Sharing Center
) E Connect to a network
Settings
B Allowed apps
P Change User Account Control 5
settings B3 programs and Featuras
¥ Controlled folder access > B system
- . -
W App & browser control > Devices and Printers
- 1 pevice Manager
e Set up USB game controllers >
= view network computers and devices
& System >
3 view network status and tasks
Search work and web
O control - see w >
£ control|Pane
H “ ”
Click “Network and Internet
Control Panel - m] X
T s Control Panel v [J] Search Control Panel yel
Adjust your computer’s settings View by:  Category ~
System and Security o User Accounts
Review your computer's status a &) Change account type

Save backup copies of your files with File History

Appearance and Personalization

Network and Internet

View network s|

%‘ View devices a
Add a device

Adjust comma

Clock and Region

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

settings, set preferences for sharing
files and computers, configure

Internet display and connection, and
more.

Programs
] Uninstall a pregram

2/}

! For more information on why IP-Addresses are necessary, see here: https://www.paessler.com/it-explained/ip-
address
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Click “Network and Sharing Center”:
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‘a Metwork and Internet

& =3 « 4 @ » ControlPa.. » Metworkand Internet +

o

Control Panel H :
ontrelFaneifiome MNetwork and Sharing Center

View network status and tasks

a network
- ter
Internet Optiol check network status, change
network settings and set preferences
for sharing files and printers.

Connect

System and Security
Network and Internet 2

Hardware and Sound

Search Control Panel

View netwerk computers and devices

Delete browsing history and cockies

Programs
User Accounts

Appearance and
Personalization

Clock and Region

Ease of Access

Click “Change adapter settings”:

:.,: Metwork and Sharing Center

&« v 5E « Netwo.. » Metwork and Sharing Center

+ o

Control Panel Home

View your active networks

Change adapter settings

IPTech 3

settings Public network

Media streaming opticns
Unidentified network
Public network

Change your networking settings

{‘ia Set up a new connection or network

Troubleshoot problems

See also
Internet Options

Windows Defender Firewall

Access type:
Connections: ) Wi-Fi (IPTech]

Access type:
Connections: @ Ethernet

Search Control Panel

View your basic network information and set up connections

Internet

Mo network access

Set up a breadband, dial-up, or VPN connection; or set up a router or access point,

Diagnose and repair network problems, or get troubleshooting infermation.

(] ped
»
[m] X
r
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Double click the adapter you’d like to use:
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Diagnose this connection

.
-

E‘ Metwork Connections
-~ ﬁl" < Metwork and... * MNetwork Connections v
Organize « Disable this network device
L.
Titems  1item selected

o

Search Metwork Connections

Rename this connection 3>

Ethernet
Unidentified network
ASIX AX88772 USB2.0to Fast ...

Click “Properties” and then double-click “Internet Protocol Version 4 (TCP/IPv4)”

[,E.] Ethernet Status

X
General
Connection
IPw4 Connectivity: Mo network access
IPvE Connectivity: Mo network access
Media State: Enabled
Duration: 00:45:05
Speed: 100.0 Mbps
Details. ..
Activity
Sent — kh ——  Received
e
Packets: 2,963 | 0
GDisabIe Diagnose

Close

0 Ethernet Properties
Networking  Sharing

Connect using:
@ ASIX AX88772 USB2.0to Fast Ethemet Adapter

This connection uses the following items:

- o X
P
B~ m
B
X

T vMware Bridge Protocal

’:]? File and Printer Sharing for Microsoft Networks

T2 Npcap Packet Driver (NPCAF)
Intemet Protocol Wersion 4 (TCP/1Pwd)

>

3 Client for Microsoft Networks A

Install...

Uninstall Properties
Description

Transmission Control Protocal/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

Cancel
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The LAN1 port of the MG400 is always set to the IP address 192.168.1.6 with subnet 255.255.255.0. Set
your IP-Address to 192.168.1.x where x is any number between 0 and 255 that is not 6. As an example, |

used this one:

Internet Protocel Version 4 (TCP/IPv4) Properties
General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

IP address: 192,168, 1 . 26

255,255,255 . 0

Obtain DNS server address automatically

Subnet mask:

Default gateway:

(®) Use the following DNS server addresses:

L. . ]

Preferred DNS server:

Alternate DNS server:

[Jvalidate settings upon exit

Leave the rest of the information blank and then hit okay to exit the IPv4 prompt. Hit okay a second time
to exit the Ethernet properties prompt.

U Ethernet Properties

General

Internet Protocol Version 4 (TCP/IPwd) Properties >

Metworking  Sharing

Connect using:

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(C) Obtain an P address automatically
(@) Use the following IP address:

IP address: [192.168. 1 .26 |
Subnet mask: [ 255,255 .255. 0 |
Default gateway: | |

Obtain DMS server address automatically

(@) Use the following DNS server addresses:

Preferred DNS server: | . . . |

Alternate DNS server: | . . . |

[ validate settings upon exit Advancedie

Cancel

? ASIX AXB8772 USB2Z 0to Fast Ethemet Adapter

This connection uses the following items:

X

aClient for Microsoft Metworks -
T Mware Bridge Protocol
’:]? File and Printer Sharing for Microsoft Networks
T3 Npcap Packet Driver (NPCAP)
3005 Packet Scheduler
4 Intemet Protocol Version 4 (TCP/IPv4)
O & Microsoft Network Adapter Multiplexor Protocol W
£ >
Install... Uninstall Properties
Description
Allows your computer to access resources on a Microsoft
network.

You are now ready to connect to the MG400.
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Connecting to the MG400 with DobotStudio2020
Open DobotStudio2020. The screen should look like this:

[@ DobotStudio2020 1.3.0-stable. 202106191640 - o X

0 Dobot Studie = {7}

Welcome to DobotStudio2020

- Brand new user interface.

Teach & Playback DobotBlockly Script
Recent Projects

@ Apple_USBC
script Apple_USBC

2 aTx_DEMO

script ATK_ DEMO

e
@ circleTest 2021-08-02 13:36:12
playback _circleTest

Remote Control
@ CamcraftPalletPr...  2021-07-26 151543

script CamcraftPalletProg

The search bar should have the MG400 pre-populated:

Connect

If this is not the case:
e Check that IP-Address is correct (See Configuring Your IP-Address)
e Check that the robot is powered on and shows a blue solid light (See Configuring Your
Hardware)

e Try the Dobot connectivity guide (See Dobot Connectivity Guide for MG400)
e If the above options all fail, get in touch with your Dobot distributor for additional support

If you are able to connect, hit connect. The robot should now be online.

Connect

[ Online |
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Enabling the Robot

In robotics, the robot is unable to move until it has

been enabled. Before enabling the MG400, Joints 2

and 3 are mechanically locked and Joints 1 and 4 can @ @
be rotated freely. This state is considered the “disabled

state.” After enabling the MG400 by left-clicking the

button shown below, the MG400 is enabled. The Disabled Enabled
robot’s joints are now active and cannot be moved by

hand.

Upon starting up and trying to enable for the first time, the MG400 will ask you for the payload
information.

Load Params

B

S

Payload ? 50 a

(=]

Offset-x

mm

The definition of “Payload” is the net weight that you have attached to the robot. The MG400 can
handle a maximum payload of 750g.

If you have not attached anything to the end of arm tool (like in the picture below), ensure that the
payload is set to 0g. Knowing this weight helps the robot determine when it has collided with something
while moving. The offset values are the x and y offsets of the center of gravity of your tool. You may
leave these offsets blank most of the time.

12
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If you attach something to the robot in the future, be sure to change the payload in the MG400 settings.

After enabling the robot, you are ready to begin motion. The front LED should now be green. If an error
appears and the robot remains disabled, that means something is preventing the robot from booting.
See Clearing MG400 Errors.

Using the Unlock Button to move the MG400 VANH
A great perk of the MG400 is the built-in unlock button. The unlock button allows the
user to “drag and drop” the robot. This allows for fast programming and development
compared to traditional methods.

To use the unlock function, simply click the button on the GM400 arm. The green light
will change to blinking blue. You can now re-position the robot freely. Be sure to click the
“unlock” button again before commanding motion.

13
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Using the Jog Panel to Move the MG400
For a more repeatable way to move the robot, the user can use the jog window to position the robot
electronically. To open the jog window, click “control” on the right side of DobotStudio2020:

e *

AV

[® Online |

DobotBlockly Script

From there, you will be able to jog the robot by either cartesian or joint moves. Here are the

cartesian/linear coordinates: Z I

““"-__f_.

14
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Here are the joint coordinates:

In “Jog” mode, the robot will jog in the selected direction until the button is released. The speed of the
robot is controlled by the speed slider on the top of the screen.

Mode Step

15
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In “Step” mode, the robot will increment the selected distance in mm whenever the user taps a button.
For example, the following button configuration would drive the robot 1mm in the x-direction when

clicked:

Mode
Inch

X 31000
Y -67.41
Z 41.87
R 27.58
J1 -12.27
J2 16.13
J3 24.46
J4 39.85

0.1

1 5 10
I+
Y+ Y R+ R-
X- Z
J1+ - 13+ J3-
J2+ J2- J4+ J4-

To get rid of the jog window, hit the “fold” button:

Dobot.us

Jser Frame

Tool Frame
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MG400 10

The MG400 has 16 digital inputs and 16 digital outputs that function on 24VDC that are visible on the
back of the robot base. The MG400 also has 2 digital inputs and 2 digital outputs on the arm of the robot

for easy access to robot tools. Dobot provides the connector for this |0 with the MG400.

USB1 USB2

To use the rear-10, compress the orange tab and insert a wire.
Release the tab and the wire should be firmly clamped in the 10 pLI7 po_1s
slot. We recommend zip-tieing your automation setup so the |10
wires don’t have any strain.

To view 10 status and toggle 10 easily, use the “I/0” tab:

17
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MG400 |0 Wiring Example
Here is an example on how to wire two 24VDC sensors with the following pinouts:

VACUUM SENSOR SOLENOID

: E@?-ﬁm o2
SR @ PIN 1 PIN 2

(4) Black (OUT1)

Brown (+)
Blue (-
Black (Out/ Analog Oul)

Ia
4

I ¥ 3 4 5 & 7 8 1011 B2 1% 14 1% 16

% [o]o[o]o[o]e]cfe] - o0

'-'_:'?]ﬂllllliHISJ.l:'r

VACUUM SENSOR SOLENOID

Note: your sensors may have different wiring. Incorrect wiring could damage the MG400.

18
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Programming the MG400

Basics

There are many ways to program the MG400. In this guide, we will cover Blockly and Script. Blockly is a
visual, block-based programming method. Script is programming in Lua, a high-level programming
language similar to Python. Generally, Blockly is friendlier to new users and quick applications while
Script is preferred by more experienced users and is suited towards

Blockly
e Visual block-building
e Also known as “Scratch” o
e Suited towards simple applications

Script
e Simple structured-text programming in Lua
o Similar to Python

e Suited towards more advanced applications/more experienced users

Script

For a first-time application, it is recommended to start with Blockly. You may port your
project to a script project (see Porting Blockly Program to Script).

19
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Saving Points

Saving points is the same in Blockly and in
Script and is usually done before writing any
code.

Open the points list in the top right of the
screen. Hitting “add” will take the robot’s

current cartesian position and save it as a point.

You can rename points by double-clicking the
name P1, P2, etc.

You can tweak a point by double-clicking an
X,Y,Z, or R value.

By clicking a point, you are given the options to
“Cover”, “RunTo”, or “Delete”. Cover will
overwrite the selected point with the current
position of the robot. RunTo will move the
robot to the selected point. Delete will remove
the point.

Dobot.us

InitialPose
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Mame

P1

P4

User

o

24743

16472

179.07

25083
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-34.55

27338

-236.4

-25.67

Caov

er

-1.239

-106.5

RunTo

41123

16177
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53.343

Drelets

11.452

-2528
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In Dobot Studio, you’ll find several move types. Here is a list of their functions and where to use them:

e Mov)
o Joint-based trajectory move to
point P
o Fastest, most efficient move

O Linear Trajectory to point P
O Good for insertions, picking parts,
paths

O Builds in a routine that
moves linearly up a
height and down to
point P
o List of parameters in settings
e JointMovl
O Move to joint position instead of
cartesian position
o Generally not used
e RelMov)
o Movl to an offset X,Y,Z,R position
instead of to a fixed point
o Joint Trajectory
e RelMovlL
o Movl to an offset X,Y,Z,R position
instead of to a fixed point
o Linear Trajectory
e Arc
o Partial circular trajectory

e (Circle
o Full circle trajectory

Dobot.us

e

Settings panel X

g Motion type

Mol Jump Jointhov]
RelMov] RelMovL Arc Circle
al
1}] Parameter configuration
g_oa:dmae:': of point InitialPose Custom
Advanced setting ~
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Blockly
Open up a new Blockly program by clicking the “Homepage” button and then clicking the
“DobotBlockly” button

@ Dobot Studio — : » +§

This will open up the Blockly Programming Interface. These are the key DobotBlockly points
of the layout: )
Points Manager,
Block Types Blocks Start/Stop 10, Jog window

Workspace

[ DobotStudio2020 1.3.0-stable.Zp

o Dobot Studio = . = untitled

@ i®

Program
managemer|

Posture

0®

y
[ S & L
\‘\ \‘\ |
|

Trash to delete
blocks

22
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Start your program by adding some points in your points list (See Saving Points).
To add a point, navigate to “Move” and then hit “Advanced configuration”:

- File M Save {4 Undo Redo (D) Debug K
® wove

Events
@ Advanced configuration
Control

fove in  Mov) * mode to point

Move in RelMovd * mode to point Ax

Operatory

[ W Move in Jump mode to point Raise
Move
. Move in Jump mode to point
Move
Arguments

. Exercise in circle mode: middle point

o

. Move in arc mode: middle point e
Program

managemer

@ Move Arguments

Fostire | I

This will open the move panel. Select your type of move and hit “Save” (for more info, see Different
Move Types)

Settings panel X

g Motion type

Mol TeimtMov]

RelMov] RelMovL f Circle

{l Parameter confjg

Coordinates of point
P:

Advanced setting

Cancel

23
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Drag the block into a position in your blockly workspace. Note
that the blocks need to “click” together.

To copy blocks, select a block, hit “ctrl + x”, and “ctrl + v’ to
paste. From there, you can edit the point names. You can also
right click and hit “duplicate” to make copies.

From there, you can make simple programs. For example, the
program shown here will move to points 1, 2, 3, and 4.

24
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in Mov.J move mode to point @

in Mowv.] move mode to point @
in Mov.J move mode to point @

in Mowv.] move mode to point @

in Mov.J move mode to point @

ogies
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Porting Blockly Program to Script
Often times, it’s easier to start in Blockly and transfer to script once the basic program is there.

Start by opening your blockly program. Be sure it is saved. Navigate to File -> Export Project

[ DobotStudio2020 1.3.0-stable, 202106191640

0 Dobot Studie =  {}

=+ File M) save <% Undo Redc !

New (Ctri+N) P

Open (Ctr+0) .
Save As (F12)

project

Import

Name the file and save it somewhere you will remember. Then hit “Export”

A Hide Folders

Export project
<« v 1 ‘r » This PC » Downloads v | O Search Downloads
Organize v New folder Bz -
~  Name Date modified Type Size
W
File name: | [y TsE
Save as type: | Project File (*.%)

Dobot.us
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After that, open up the script interface.

V) a~
@ Dobot Studio — : » E/

Script
Go to File -> Import project and select your exported project
[ DobotStudio2020 1.3.0-stable. 202106191640
0 Dobot Studio —
F=- File [ save <% Undo Redo
New (Ctrl+MN) Q,
Open (Ctrd+0)
Save As (F12)
point, the target point is =
Import project g point El
Export project
“ P Linear Movement o
3
Movl *
7 P~ Point to point, the target point is &
Joint point *
Import from: X
&« v ‘ > This PC + Downloads » v O Search Downloads »
Organize = MNew folder Bz~
G Mame Date modifi\e/d Type Size N
~ Today (1)
myBlocklyExample 9/13/2021 411 PM File folder
v v
Folder: | myBlocklyExample |
Open | | Cancel |

Your blockly program will now be displayed as script.

26
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Blockly Example 1: Basic Moves
This program will run to points 1, 2, 3, and 4. At each point, the MG400 will wait 1 second to proceed.
This process will repeat 10 times before ending.

27
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Blockly Example 2: Using 10 #1
This program will execute a loop 10 times. Each time, it will wait until Digital Input 1 is high. After the
signal goes high, it will execute 10 times.

Stop at this point

repeat until Read status of digitalinput DI 01 «

Stop at this point

in Mov.J move mode to point @

Without the “Stop at this point” command, the program will not work. For more information on why
the Sync function is necessary, see Using Sync with IO Commands.

Remember you can monitor this with the |0 panel to help debug: (right side of studio)

Eody I/0
Digital input name
ol_o1 - DI_09 ®

DI_02 L] D10 ]

28
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Blockly Example 3: Modified Parameters in Move
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By right-clicking a move and hitting “edit”, you may make special configurations for that move. For
example, you can have slower velocity and acceleration on an insertion move. Or you can Have an 10

toggle a certain distance into a move.

in MovJ move mode to point @

in MovJ move mode to point @

in MovJ move mode to point @ Advanced configuration EE:ELMESSIH

in MovJ move mode to point @ Advanced configuration &N

in MovJ move mode to point @
in MovJ move mode to point @

in MovJ move mode to point @

in MovJ move mode to point @ Advanced configuration &N

g_oord.i.uanes of pomt Pa Custom
Advanced setting ~
B Speed <O
B Acceleration O
CP O
B Process I/ O settings 2
DO_01 = OFF
Trigger mode Distance
Distance 2 mm
I
Cancel Save
29
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Script
Open up a new Script program by clicking the “Homepage” button and

then clicking the “Script” button
V) /-
) L
Script

This scripting language is called Lua. It is similar to Python and should be
familiar to those who know structured text programming. Aside from the Dobot functions, everything in
Lua is supported here.?

@ Dobot Studio =  {}

There are two files that open on bootup: scr0.lua and global.lua.

e scr0.lua
o Used for motion commands
o Used for sequential code

e global.lua
o Used for global variables
o Used for user functions

e scrl.lua, scr2.lua, etc.
o User may create as many parallel threads as they desire by hitting the +

srcl.lua P global.lua X

o Recommended for monitoring 10, TCP/IP communications, etc.
o Itisrecommended to avoid motion commands in parallel threads. This could lead to
erratic behavior

2 If you are unfamiliar with structured-text programming, there is a great Lua guide here:
https://www.tutorialspoint.com/lua/index.htm

30
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Robot Functions

Start/Stop

Workspace
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Points Manager,
10, Jog window

[ DobotStudio2020 J.0-stable.202106191640

0 Dobot itudio =

B @z )

- File P save

< Undo

Je)

(©) Debug

|« 3nline |

M. Metion
Param

el 1/0

& Uil

Pose

TCP

upP

Modbus
Conveyer Belt

Stack

@ i®

3

Dobot.us
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Users may use the built-in robot functions on the left to quickly deploy code without worrying about
Syntax:

[=] M Motion

? P Point to point, the target point is

Cartesian point

Mlow] \
Double-Click to insert

a command Double-Click to insert
sre0.lua X globallua O a command with
optional parameters

= srcO.lua X global.lua x T
1 1loeal Cpticn={CP=1l, SpeedJ=30, Accd=20}

2 MovJ({P, Opticn)

“on

signifies a comment in Lua

32
Dobot.us 0

DOBOT



In-P©s"ri©n
Technologies

Script Example 1: Basic Moves
This script runs to P1 and P2 with normal parameters. Afterwards, it goes to P3 with 50% speed and 20%
velocity with a CP = 1.

src0.lua

MovdJ (P1)
MovL (P2)
MovJ (P3, {CP=1, Speedd=50, AccJ=20})

global.lua

Script Example 2: Basic IO Operations
This script iterates 10 times in a loop. It starts by moving to P3 and then will move to P1is DI1 is high or
P2 if DI1 is not high.

src0.lua

for count = 1, 10 do
MovdJ (P3)
Sync ()
if (DI(1))==1 then
MovJ (P1)
else
MovdJ (P2)
end
Wait (1000)
end

global.lua
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Script Example 3: Custom Function

If you have repetitive code, use a custom function to save on time and programming efficiency. The
below example uses a custom function named “partinsertion()”. That function is defined in global.lua
and called in scr0.lua during execution.

"riQn
ogies

src0.lua

while true do
MovdJ (P1)
MovJ (P2)
partInsertion ()
MovdJd (P3)
partInsertion ()
MovJ (P4)
partInsertion ()
Wait (1500)

end

global.lua

function partInsertion ()
RelMovL ({0, 0, -10,0}, {CP=0, SpeedlL=20, AcclL=20})
Sync ()
DO (1, ON)
Wait (1500)
Sync ()
DO (1, OFF)
RelMovL ({0,0,10,0})
end
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Script Example 4: TCP/IP Client
You can have the MG400 run a program on-board

src0.lua

local ip="192.168.1.6"
local port=6001

local err=0

local socket=0

err, socket = TCPCreate (true, ip, port)
if err == 0 then
err = TCPStart (socket, 0)
if err == 0 then
local RecBuf
while true do
TCPWrite (socket, "tcp server test")
err, RecBuf = TCPRead (socket,10,"string")

if err == 0 then
Go (P1)
Go (P2)
print (RecBuf.buf)
else
print ("Read error ".. err)
break
end
Wait (100)
end
else
print ("Create failed ".. err)
end
TCPDestroy (socket)
else
print ("Create failed ".. err)
end
global.lua

This may be run with the python script shown here:

A

MG400_simpleSock
et.py
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Script Example 5: Variable palletizing
This script takes in variables for X,Y,Z, and R positions of two pallets sitting in any X-Y plane. This
example program is of a pick + camera inspect + place sequence.

|1i@n
ogies

src0.lua

cameraSignal in = 5
cameraSignal out = 3

gripperSignal out = 2

X _input startingPoint = 300
y_input startingPoint = 100
X input pallet = 10

y_input pallet = -25

z input pallet = 10

r input pallet = 90

X input num iterations = 4
y input num iterations = 3

num parts input pallet = x input num iterations * y input num iterations

x_output startingPoint = 250
y_output startingPoint = -70
X _output pallet = -15
y_output pallet = 26

z _output pallet = -10

r output pallet = 0
x_output num iterations = 3
y_output num iterations = 4

num parts output pallet = x output num iterations * y output num iterations

X _input iter = 0
y_input iter = 0
x_output iter = 0

y_output iter = 0
input pallet finished = 0
output pallet finished = 0

pickPoint = {armOrientation="right",
coordinate={x input startingPoint+x input iter*x input pallet,
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y input startingPoint+y input iter*

0.000000, 0.000000},to0l=0, user=0}
placePoint={armOrientation="right",

coordinate={x output startingPoint+x output iter*x output pallet,
y output startingPoint+y output iter*y output pallet,
0.000000}, tool=0,

r output pallet, 0.000000,

Go (clearPoint)
print ('Starting Program')
while (input pallet finished == 0)

MovJ (pickPoint)
inputPalletIter ()
pickPart ()

MovJ (cameraPoint)

DO (cameraSignal out, ON)
Sync ()

Wait (500)

DO (cameraSignal out, OFF)
Sync ()

if DI(cameraSignal in)==0FF then
MovJ (placePoint)
outputPalletIter ()
placePart ()

else
MovJ (dumpPoint)
placePart ()

end

end

Go (clearPoint)

y input pallet, z input pallet, r input pallet,

z output pallet,
user=0}

and (output pallet finished == 0) do

global.lua

function pickPart ()
local Offset = {0, 0, =10, 0}
local Option={CP=1, SpeedL=50,
RelMovL (Offset, Option)
Sync ()
DO (gripperSignal out, ON)
Wait (500)
Offset {0, O,
RelMovL (Offset,
Sync ()

10, 0}
Option)

AccL=20}

Dobot.us
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end

function placePart ()
local Offset = {0, 0, =10, 0}
local Option={CP=1, SpeedL=50, AccL=20}
RelMovL (Offset, Option)
Sync ()
DO (gripperSignal out, OFF)
Wait (500)
Option={CP=1, SpeedlL=100, AccL=75}
Offset = {0, 0, 10, 0}
RelMovL (Offset, Option)
Sync ()
end

function inputPalletIter ()

if (x_input iter+l) < x input num iterations then

X _input iter = x input iter + 1
elseif (y input iter+l) < y input num iterations then

print ('GOT HERE')

X _input iter = 0

y_input iter y_input iter + 1
else

print ('INPUT PALLET DONE')
X _input iter = 0
y_input iter = 0
input pallet finished = 1
end
pickPoint = {armOrientation="right",
coordinate={x_input startingPoint+x input iter*x input pallet,
y_input startingPoint+y input iter*y input pallet, z input pallet,
0.000000, 0.000000},to0l=0, user=0}
Sync ()
end

function outputPalletIter ()

if (x output iter+l) < x output num iterations then

x_output iter = x output iter + 1
elseif (y output iter+l) < y output num iterations then

print ('GOT HERE')

r input pallet,

x_output iter = 0
y_output iter = y output iter + 1
else
38
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print ('OUTPUT PALLET DONE')
x output iter = 0
y output iter = 0
output pallet finished =1
end
placePoint={armOrientation="right",
coordinate={x output startingPoint+x output iter*x output pallet,
y _output startingPoint+y output iter*y output pallet, z output pallet,
r output pallet, 0.000000, 0.000000},tool=0, user=0}
Sync ()
end
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Troubleshooting & Documents
Dobot Connectivity Guide for MG400

How to connect
MG400 using software

Hardware User Guide

Dobot MG400
Hardware User Guide

DobotStudio2020
Dobot User Guide

PIF
DobotStudio2020

User Guide V1.1.1(2020)

MG400 Specs

MG400 specs.pdf

Clearing MG400 Errors
The MG400 will error out when the user tries to perform one of many forbidden actions or the robot
cannot perform a given task. You can tell the robot is in an error state without a PC because the front
LED will be blinking red. Common cases where a user can see an error include:

e Attempting to enable in an invalid position

e A collision was detected

e The robot is violating the parallelogram limits (too close to the base)

e The user attempted to command the robot to hit itself or move outside the max reach
An error is indicated by the log in the top right of DobotStudio2020:

~

(@ Online |

To clear the error, press the log and view what the error was. It may require you to resolve the issue
before hitting “clear alarm.”
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LED Functionality
The LED on the front right of the MG400 base can glow several colors. This tells us what state the robot

is in without needing a computer.

Color State Meaning

White Blinking Booting

Blue Solid Ready,
disabled

Blue Blinking Unlock button
pressed — free
to drag robot

Green Solid Enabled, Ready

Green Blinking Executing
Program

Red Blinking Error

Using Sync with IO Commands
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The Sync() function (“Stop at this point” in blockly) is essential for the use of MG400 DIO.

The reason for this is queuing. Similar to other robots, the MG400 compiles all commands very quickly
and then executes them in real time. The reading of inputs is generally queued immediately and not in
sync with the real-time execution, like we generally want 10 to be.

When reading from an 10 or writing to an |10, use a Sync() or Stop at this point block before the 10
command, like shown below:

Reading from an IO

in MovJ move mode to point @

Stop at this point

Read status of digitalinput D01~ = (§])
in MovJ move mode to point m

in MovJ move mode to point @

|

.-_.:'\/1\.
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Writing to an 10

set the status of digital output DO 01+ to ON »

in MovJ move mode to point @

in MovJ move mode to point (ZJ)

set the status of digital output DO 01 » to OFF »
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Contacts

Don’t hesitate to reach out for help, questions, and sales. You may reach IP-Tech Dobot support in any
of the following ways:

Phone
Customer Service/Sales: 877-478-3241

Email
Help email: help@iptechl.com
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